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Document Overview

This document provides a configuration guide for Sonus SBC 5XX0 Series (Session Border Controller) when connecting to Genesys Voice Platform.
This configuration guide supports features documented in the Genesys Voice Platform guides.

® For additional information on Genesys Voice Platform, please visit http://www.genesys.com/
® For additional information on Sonus SBC, please visit http://sonus.net.

Introduction

The interoperability compliance testing focuses on verifying inbound and outbound calls flows between Sonus SBC 5XX0 and Genesys Voice
Platform.

Audience

This is a technical document intended for telecommunications engineers with the purpose of configuring both the Sonus SBC and the third-party
product. There will be steps that require navigating third-party as well as the Sonus SBC Command Line Interface (CLI). Understanding the basic
concepts of TCP/UDP, IP/Routing, and SIP/RTP are also necessary to complete the configuration and for troubleshooting, if necessary.

@ This configuration guide is offered as a convenience to Sonus customers. The specifications and information regarding the product in this
guide are subject to change without notice. All statements, information, and recommendations in this guide are believed to be accurate, but
are presented without warranty of any kind, express or implied, and are provided "AS IS." Users must take full responsibility for the
application of the specifications and information in this guide.

Requirements

The following equipment and software were used for the sample configuration provided:

Table 1: Requirements

Equipment Software Version
Sonus Networks Sonus SBC 5200 VV05.01.01-R000
BMC Vv02.16.00
BIOS Vv02.06.00
ConnexIP OS Vv03.01.01-R000
SonusDB V05.01.01-R000
EMA V05.01.01-R000
SBX V05.01.01-R000
Third-party Equipment = Genesys SIP Server 8.1.100.98
Genesys GVP MCP 8.1.504.93

Polycom SoundPoint IP 501 SIP = 2.1.3

Reference Configuration

The following reference configuration shows connectivity between third-party and Sonus SBC 5XX0.

Figure 1: Connectivity Between Third-Party and Sonus SBC 5XX0
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Support

For any questions regarding this document or the content herein, please contact your maintenance and support provider.

Third-Party Product Features

The testing was executed with the Genesys test plan. The following features were tested:
Inbound calls

Inbound Call to Agent released by caller

Inbound Call to Agent released by agent

Inbound Calls rejected

Inbound Call abandoned

Inbound Call to Route Point with Treatment

Interruptible Treatment

IVR (Collect Digit) Treatment

Inbound Call routed by using 302 out of SIP Server signaling path

Outbound Calls

® 1PCC Outbound Call from SIP Endpoint to external destination
® 3PCC Outbound Call to external destination
® 1PCC Outbound Call Abandoned

Music on hold

® Caller is put on hold and retrieved by using RFC 2543 method
® T-Lib-Initiated Hold/Retrieve Call with MOH using RFC 3264 method

Call Transfers

3PCC 2 Step Transfer to internal destination by using re-INVITE method
3PCC Alternate from consult call to main call

1PCC Unattended (Blind) transfer using REFER

1PCC Attended Transfer to external destination

3PCC Two Step Conference to external party

3PCC (same as 1PCC) Single-Step Transfer to another agent

3PCC Single Step Transfer to external destination using REFER

3PCC Single Step Transfer to internal busy destination using REFER

Other scenarios

Early Media for Inbound Call to Route Point with Treatment

Early Media for Inbound Call with Early Media for Routed to Agent
Inbound call routed outbound (Remote Agent) using INVITE without SDP
Call Progress Detection

Out of Service detection. Checking MGW live status

SIP Authentication for outbound calls

SIP Authentication for incoming calls

Remote Agent behind SBC scenarios

® T-Lib-Initiated Answer/Hold/Retrieve Call for Remote SIP endpoint which supports the BroadSoft SIP Extension Event Package
® 3PCC Outbound Call from Remote SIP endpoint to external destination
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® 3PCC 2 Step Transfer from Remote SIP endpoint to internal destination
® 1PCC Attended Transfer from Remote SIP endpoint to external destination

Verify License
SBC-POL-RTU

Genesys Voice Platform Configuration

The following new configurations are included in this section:

. Accessing Genesys Tools and Interfaces

. Creating SIP Switch in Genesys Administrator

1
2
3. SIP Server Configuration in Genesys Administrator
4. Genesys Media Server Deployment

5

. Stat Server Configuration

1. Accessing Genesys Tools and Interfaces

This section provides the configuration required for the Genesys components.

Genesys is configured using several different tools and interfaces. The tools and interfaces used in this document are shown below to include their
location and method of access.

To access these items, a Remote Desktop Connection (RDC) to the Genesys server is required. The username, password, and IP address of the
system to be accessed should be provided by the person(s) installing the Genesys system.

Once logged onto the Genesys system, click the Start button and look for the installed applications shown below. If the applications are not visible on
the Start Menu, find them using the search box just above the Start button.

® The Solution Control Interface is used to start/stop the various applications, as well as identify the configuration of each application.
® The Configuration Manager is a tool used to configure and verify the many settings on the different applications.
® The Interaction Routing Designer is used to create and configure Route Points and strategies.

® Internet Explorer (not shown in the startup menu) is used to access the Genesys Administrator. The URI should be available from those who

installed the platform.
@ Steps can be performed using multiple tools. For example, starting or stopping an application can be performed in the Genesys

Administrator as well as the Solution Control Interface.

Figure 2: Access Solution Control Interface
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= Below is a screenshot of the Solution Control Interface. In this application, click View, top left, to gain access to the area of interest. Click App
lications and expand the folders of interest. In this example, SIPServerl properties are displayed. Clicking the various links will display the

appropriate property windows. You can Start/Stop/GracefulStop any application from within this tool.

Figure 3: Solution Control Interface
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® The Configuration Manager is used to configure the platform and its applications. Once opened, click Applications/Media (it's possible that
your SIP Server is in a different folder under Applications) and the upper left pane will display both SIP Servers. Double-click SIPServerl1 and
a dialog box will open. To view all options for this server, click the Options tab, and then click the TServer section.
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Figure 4: Configuration Manager
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Note that there are many option parameters. Type the name of the option in the filter "notice that it filters in real time". Some options can be set at
both Application and Switch/DN levels. The option setting at the DN level takes precedence over the Application-level setting. See the Genesys SIP

Server Deployment Guide for details.

Figure 5: SIP Server Properties
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" The Interaction Routing Designer is a tool used to create Route Points and/or Strategies. Access the Strategies by clicking Routing
Design>Strategies. Double-clicking any strategy will bring up a second window (not shown here). This second window is where Strategies

can be created and modified.

Figure 6: Interaction Routing Designer
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® Access the Genesys Administrator with a web browser. Contact the administrator or person(s) who performed the install of the system to
determine the URL. Once opened, click the Provisioning tab and under the Navigation area click Switching. Under Switching, click Switches
to display the names of the Switch objects.

Figure 7: Genesys Administrator - Switches
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® Double-click the switch name and then click the DNs tab. The DNs for your SIP Switch will be shown. Each folder can be double-clicked to
access the contents. Underlined are the bread crumbs for navigation. Circled is the icon area to add new DNs or delete existing ones.

Figure 8: Genesys Administrator - DNs
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2. Creating SIP Switch in Genesys Administrator

= Within Genesys Administrator, create a Switching Office named SIPServer Switching Office.

Figure 9: Genesys Administrator - Creating SIP Switch
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= Within Genesys Administrator, create a SIP Server Switch and associate the Switching Office created in the previous step with this switch.

Figure 10: Genesys Administrator - SIP Switch Association
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= Under the SIPSwitch created in the above step, define Routing Points to run URS strategies from, the SIP trunk representing connection of

SIP Server to Sonus, and a “msml” VolP service DN required to integrate SIP Server with Media Server to support call hold and conferencing
functionalities.

Figure 11: Genesys Administrator - Define Routing Points
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= Define DNs of type Extension under SIPSwitch with the following options in the TServer section for various SIP endpoints that will register to

the SIP Server.

® use-contact-as-dn=true — Specifies whether SIP Server will use the username of the Contact header as ThisDN.
® contact=* — Specifies the contact address of the extension DN to which SIP Server should send the SIP call. Here the Contact
option value is the IP address of the internal interface of Sonus through which the SIP REGISTER message was received by SIP

Server.

® cpn=<2086041001> — SIP Server uses the value of this option as the user part of the SIP URI in the From header of the INVITE
message that it sends from this DN to the destination DN. Since this option is used to provide customized caller-ID information to the
destination, this option must be configured in the originating DN.

® sip-cti-control=talk,hold — The SIP method NOTIFY (event talk) or NOTIFY (event hold) is used to request the end point to answer

or place a call on hold, respectively.

Figure 12: Genesys Administrator - Extension Options
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= Define a SIP trunk DN to represent all SIP calls arriving from the Sonus SBC internal interface to the SIP Server. Configure the following

options under the TServer section of the Trunk DNs.

Trunk DN:

® contact=<10.35.141.52:5060> — IP address and TCP/UDP port number of the SIP Signaling Port of the Sonus SBC 5000
configured for Genesys. The SIP Signaling Port IP address is used by SIP Server to route or receive calls from test phones through

this interface.

® cpd-capability=mediaserver — Specifies whether SIP Server will use the username of the Contact header as ThisDN.

¢ dial-plan=DialPlaninbound — Specifies which dial-plan DN will be applied to calls

® prefix=<214340> — (NPANXX) Specifies the contact address of the extension DN to which SIP Server should send the SIP call.
Here the Contact option value is the IP address of the SIP Signaling Port of the Sonus SBC 1000/2000 through which the SIP

REGISTER message was received by SIP Server.

Figure 13: Genesys Administrator - SIP Trunk Options
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" Define an MSML voice over IP service DN with the following options in the TServer section:
® contact-list=<IP Address:Port>— SIP IP address and listening port for Resource Manager.
® oos-check=15 - Specifies how often (in seconds) SIP Server checks a device for out-of-service status.
® oos-force=20 — Specifies the time interval (in seconds) that SIP Server waits before placing a device that does not respond in out-of-
service state when the oos-check option is enabled.
® prefix=msml= — Required for conference and monitoring services only.
® service-type=msml — Specifies the configured SIP device type or service.
® subscription-id=Resources — Specifies the type of subscription ID.

Figure 14: Genesys Administrator - Define MSML
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= Verify GVP_RM Pair settings:

® prefix=msml=— Required for conference and monitoring services only.

* refer-enabled=false — Specifies the configured SIP device type or service.

® ring-tone-on-make-call=false — Affects the TMakeCall request when using the re-INVITE procedure. When the ring-tone-on-make-
call option is set to false, there is no ring tone.

®* make-call-rfc3725-flow=1 — Setting this option to 1 instructs SIP Server to use the 3pcc call flow as defined in the RFC 3725.

Figure 15: Genesys Administrator - GVP_RM Pair Settings
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® Create DNs of type Routing Point in the SIPSwitch which should match the Request URI user part. In this instance it was extensions 1011-
1015.

Figure 16: Genesys Administrator - Create DN of Type Routing Point
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Figure 17: Genesys Administrator - Routing Strategies
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" The SIP Server must have Full Control permission for the DN objects under the SIP Server Switch, in order to update various configuration
objects under it, such as the Extension DNs.

By default, it does not have this permission. You must grant “Full Control” permission for the System account for the all DNs on the corresponding
switch. It is done for all DNs at once by changing the permissions for the system account on the DN folder in the switch object. Or, you can start SIP
Server under another account that has change permission on the necessary DNs.

With this full control access, the SIP Server Switch grants DNs like Extension to update their options like “contact” when a new SIP register message
is received from end points moving to a new IP location

3. SIP Server Configuration in Genesys Administrator

Follow these steps to configure the SIP Server to monitor SIP Server Switch resources, such as SIP extensions/SIP end points registered to SIP
Server. The SIP Server also monitors various route points and notifies URS whenever the call arrives on the Route Point.

" |nstall and configure SIP Server as per Genesys Framework SIP Server Deployment Guide.

® Add a connection to the SIP Server Switch created above, to monitor all the resources under this switch: Genesys Administrator->
Provisioning->Environment->Applications->SIP Server Application. Also, SIP Server should add a connection to the tenant.

Figure 18: Genesys Administrator - SIP Server Tenant
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® Add a connection to Message Server.

Figure 19: Genesys Administrator - Add Connection to Message Server
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= Configure the following options in the TServer section in the SIP Server Application object using Genesys Administrator or Configuration

Manager:

® sip-enable-moh=true — Enables music on hold.

® msml-support: true — This option and sip-enable-moh (above) allow SIP Server to integrated with Genesys Media server to provide
msml/moml-based media services.

® map-sip-errors=false — Genesys Universal Router makes the routing decision for the SIP Server-based solution. If a call fails to
route properly, the SIP Server generates an appropriate T-Library error message to inform the router. With this new parameter, SIP
Server can now propagate SIP error messages to the router. Setting map-sip-errors=false triggers this functionality in SIP Server.

® internal-registrar-persistent=true — Enables SIP Server to update the DN attribute contact in the configuration database. When an
endpoint registers, SIP Server takes the contact information from the REGISTER request and updates or creates a key called
contact in the Annex tab of the corresponding DN.
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® sip-dtmf-send-rtp=true — In order to support DTMF tone generation on behalf of a 3pcc-based SIP end point application such
as Interaction Workspace SIP end point. When this option is set to true, SIP Server requests Media server to generate RFC 2833
DTMF tones on behalf of the end point.

® after-routing-timeout — Set to 10 seconds. If SIP Server does not get a response on routing a call to SIP agent/Extension DN, it will
attempt to route the call to another DN (or default-dn) on expiration of this timer. You must set this timer to be less than the
parameter rq-expire-tmout value of 32000 (32 seconds).

= S|P Server is able to start properly with the proper FlexLM license installed.

4. Genesys Media Server Deployment

Follow these steps to configure a Media Server deployment.

Media Server platform consists of Resource Manager and Media Control Platform applications in the Genesys Voice Platform product suite. To
deploy, Media Control Platform and optionally a Resource Manager are required to be installed. When installed, Resource Manager serves as the
ingress point to Media services and provides a MCP resource as a media service to the network/calling side.

1.
2.

Install and configure MCP (Media control Platform) using the Genesys Media Server Deployment Guide.

Within the MCP application’s Connections tab, add connections to SNMP Master Agent, Message Server, and Reporting Server
(optional).

The connections to applications are added for the following reasons:

Message Server - To ensure that component log information reaches the Log database and can be viewed in the Solution Control Interface
(Cle)]

Reporting Server - (Optional) To ensure that these components detect the Reporting Server to which they are sending reporting data.

SNMP Master Agent - To ensure that alarm and trap information is captured.

. Verify VolP service DN of type=msml as specified in section Creating SIP Switch in Genesys Administrator to support SIP Server-Media

Server MSML interactions to support treatments and conferencing capabilities.

. To play music on hold (MOH) and music treatments, verify the following options are set in MCP and SIP Server:

MCP->msml-> play.basepath = file://$InstallationRoot$ (this is the installation folder of Media Server. After this is, it will automatically look
for the music sub folder).

“MOH” and music treatments are located in the “music” folder.

The ‘announcement” folder should contain ‘prompt’ files with proper IDs to support. Used in the URS Routing Strategies as mentioned in
chapter 0.

SIP Server->TServer->msml-support=true

. Install and configure Resource Manager as per Genesys Media Server Deployment Guide.

Note: If SIP Server and Resource Manager are on the same machine and within the Resource Manager application, then the default SIP
listening port number should be increased by 100 so the Resource Manager listening port is set to 5160 and the SIP Server application
listens on port 5060. Make the necessary port changes within Resource Manager’s sip, proxy, register, subscription, and monitor sections.

. Within the Resource Manager application’s Connections tab, add connections to SNMP Master Agent, Message Server, and Reporting

Server (optional).
The connections to applications are added for the following reasons:

Message Server - To ensure that component log information reaches the Log database and can be viewed in the Solution Control Interface
(SCl).

Reporting Server - To ensure that these components detect the Reporting Server to which they are sending reporting data. (Optional).

SNMP Master Agent - To ensure that alarm and trap information is captured.

. Within the Integrating Media Control Platform with the Resource Manager, click the Media Control Platform Application object. TheConfigurat

ion tab appears.

Click the Options tab, and use the View drop-down list to select Show options in groups...
Select sip to find the routeset option.
In the Value field, type the following:

<sip:IP_RM:SIPPort_RM;Ir>
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Where IP_RM is the IP address of the Resource Manager, and SIPPort_RM is the SIP port of the Resource Manager—typically, 5060.

Note: You must include the angle brackets in the Value field in the sip.routeset and sip.securerouteset parameters.

In the Value field of the securerouteset option, type the following:

<sip:IP_RM:SIPSecurePort_RM;lr>

8. G.729 media codec is not configured by default as a supported codec or as a codec that can be transcoded. This support can be enabled by
adding “g729” as one of the values to the mpc.codec and mpc.transcoders space separated list. The G.729 media codec was not
provisioned in this Genesys deployment and is only mentioned here for completeness.

Example:
mpc.transcoders=PCM GSM G726 G729

mpc.codec=g729 pcmu pcma g726 gsm h263 h263-1998 h264 telephone-event

Alternately Media Server (specifically MCP component) can be configured to respond a multiple codec offer request with a single codec
response. This feature support is available starting with MCP 8.1.4 release.

This setting can be enabled by setting mpc.answerwithonecodec=1 (Default=0 — MCP responds to multiple codec offer with a multiple
codec response list).

9. This step is optional and is only required if multiple media control platform (MCP) instances are deployed and need to be controlled by

Resource Manager for load balancing.

Log in to Genesys Administrator.

On the Provisioning tab, click Voice Platform>Resource Groups.

On the Details pane tool bar, click New.

The Resource Group Wizard opens to the Welcome page.

On the Resource Manager Selection page, add the Resource Manager Application object for which you want to create the group. On the
Group Name and Type page: enter MCPGroup or any custom name without spaces. Select type as Media Control Platform.

On the Tenant Assignments page, add the child tenant to which the Resource Group will be assigned.

PONE

o

® Note: -The above bullet item is required only if you are creating the Resource Group in a multi-tenant environment.
6. On the Group Properties page, enter the information as specified below for the Resource Group that you are configuring.

Monitoring Method: Retain the default value: SIP OPTIONS.
Load Balance Scheme: Select round-robin.

Port Usage Type: Select in-and-out.

Maximum Conference Size: Enter -1.

Maximum Conference Count: Leave blank.

Note: For the Media Control Platform group, the Max.Conference Size and Max.Conference Count, and the Geo-location options are optional.
For a complete list of resource-group options and their descriptions, refer to the Genesys Voice Platform User’s Guide.

In this step, you create a default IVR Profile that can be used to accept calls other than those specified in the dialing plans.

. Log in to Genesys Administrator.
. On the Provisioning tab, select Voice Platform>IVR Profiles.

. Inthe Tasks panel, click Define New IVR Profile. The IVR Profile Wizard opens to the Welcome page.

1

2

3

4. On the Service Type page, enter the name of the default IVR Profile, IVR_App_Default.

5. Select either Conference or Announcement from the drop-down list. (Only one service type per IVR Profile is supported.)

6. If you selected Conference, on the Service Properties page, enter a conference ID number.

7. If you selected Announcement, on the Service Properties page, enter the URL of the announcement, for example, http://webserver/hello.wav.
8

. Click Finish.

®* Note: When you use the IVR Profile Wizard to create the default profile, the gvp.general and gvp.service-prerequisites sections are
created for you and include the required parameters
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9. In the gvp.general section of the Tenant's Annex tab, set the default-application to this default IVR Profile name — IVR_App_Default.

This completes installation and configuration of Media Server. Make sure Resource Manager and MCP are started successfully.

5. Stat Server Configuration

This section explains configuration of Stat Server that connects with T-Servers/SIP Servers and maintains agent and/or extension status which is
used by URS during call routing.

1. Install and configure Stat Server per the Genesys Framework Stat Server Deployment Guide.

2. Add connections to SIP Server, Message Server to perform real-time monitoring of the SIP agent status.

Figure 20: Genesys Administrator - Stat Server Connections
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6. Universal Routing Configuration in Genesys Administrator

This section explains how to configure a Universal Routing Configuration (URS) to support execution of call routing on SIP Server.
1. Install and configure Universal Routing Server per the Genesys Universal Routing Deployment Guide.
2. Add connections to Message Server, Stat Server, and SIP Server.

3. Add connection to SIP Server to monitor events received by SIP Server for various route points and extensions on the SIP Server Switch.

4. Add connection to Stat Server to query Stat Server for routing calls to available and ready agents.

Figure 21: Genesys Administrator - URS Configuration
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Use any of the strategies below to test your configuration.

7. URS Routing Strategies

This section shows examples of five URS routing strategies used during testing.
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" Strategy #1 - Route Call to Available Agent

When RP 1011 is invoked, this strategy routes the call to the next available agent. If no agent is available, it plays MOH until one becomes
available.

Figure 22: URS Strategy #1
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" Strategy #2 - Play Announcement and Route to Available Agent

When RP 1012 is invoked, this strategy plays an announcement and routes the call to the next available agent. If no agent is available, it
plays MOH until an agent becomes available.

Figure 23: URS Strategy #2
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Figure 24: URS Strategy #2 - Target Selection
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® Strategy #3 — Play Announcement and Collect Seven Digits

When RP 1013 is invoked, this strategy verifies that any seven digits can be collected and then routed to an available agent. If no agent is
available, it plays MOH until an agent becomes available.

Figure 25: URS Strategy #3
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Figure 26: URS Strategy #3 - Prompt Tab
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Figure 27: URS Strategy #3 - Busy Tab
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Figure 28: URS Strategy #3 - Target Selection
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" Strategy #4 — Route to External SIP Carrier Number

When RP 1014 is invoked, this strategy immediately routes the call to an external SIP Carrier number.

Figure 29: URS Strategy #4
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3 Function properties
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" Strategy #5 — Route to External SIP Carrier Number

When RP 1015 is invoked, this strategy plays an announcement and then immediately routes the call to an external SIP Carrier number.

Figure 30: URS Strategy #5

)

[ f
o —
L

M

Pasameters | FROMPT |

|

[ st for Tiestment end

Parameter

Figure 31: URS Strategy #5 - Prompt Tab
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Figure 32: URS Strategy #5 - Function Properties
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5 Function properties
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ransport Prot ocol sAl | owed si p-udp

node i nService

tate enabl ed

GENESYS i pAddress 10.35.176. 111

GENESYS i pPort 5060

GENESYS aut henti cation intChal | engeResponse enabl ed
GENESYS aut henti cation inclnternal Credentials enabl ed

TWO WAY- S| P- GENESYS pol icy cal |l Routing
TWO- WAY- SI P- GENESYS policy signaling ipSignalingProfile

TWO- WAY- SI P- GENESYS nedi a nedi al pl nt er f aceG oupNane TRUSTED
TWO- WAY- SI P- GENESYS i ngressl pPrefix 10.35.176.111 32

TWO WAY- SI P- GENESYS npde i nServi ce

TWO- WAY- S| P- GENESYS st ate enabl ed

UNTRUSTED ceNane LI TTLE
UNTRUSTED port Nanme pkt 2
UNTRUSTED i pAddr ess 10. 35.177. 150
UNTRUSTED prefix 26

UNTRUSTED node i nService
UNTRUSTED st at e enabl ed

i plnterface
i plnterface
iplnterface
i plnterface
i plnterface
iplnterface

177.129 UNTRUSTED UNTRUSTED pref erence 100

i pl nterfaceG oupNane UNTRUSTED

i pAddressVv4 10. 35.177. 151

port Nunber 5060

transport Prot ocol sAl | owed si p-udp, sip-tcp
node i nService

state enabl ed

Addr ess 10. 35. 8. 146

Port 5060

rrogat eRegi strati on aut hUser Name 2086041020

rrogat eRegi stration regAut hPassword 123456

rrogat eRegi strati on sendCredential s chal | engeFor AnyMessage
thentication intChall engeResponse enabl ed
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set addressCont ext
conmmi t

#SI P trunk groups
#PSTN t runk

set addr essCont ext
TG ERP

set addr essCont ext
GENESYS_| PSP

set addressCont ext
set addr essCont ext
set addr essCont ext
set addr essCont ext
conmmi t

#RDN t runk

set addressContext default zone

def aul t

def aul t

def aul t

defaul t
def aul t
def aul t
def aul t

zone TRUSTED

zone TRUSTED

zone TRUSTED
TRUSTED
TRUSTED
TRUSTED
TRUSTED

zone
zone
zone
zone

TRUSTED

el enent RoutingPriority TG ERP

set addressContext default zone

ACCESS_| PSP

set addressContext default zone

TRUSTED

TRUSTED

requireRegi stration required

set addr essCont ext
UNTRUSTED

set addr essCont ext
set addr essCont ext
set addressCont ext
conmmi t

default zone

default zone
default zone
default zone

TRUSTED

TRUSTED
TRUSTED
TRUSTED

i pPeer

si pTrunkG oup
si pTrunkG oup
si pTrunkG oup
si pTrunkGr oup
si pTrunkG oup
si pTrunkG oup
si pTrunkG oup
si pTrunkG oup
si pTrunkG oup
si pTrunkGr oup
si pTrunkG oup

si pTrunkG oup
si pTrunkG oup

TWO- WAY- S| P- PSTN

TWO- WAY- S| P- PSTN

TWO- WAY- S| P- PSTN
TWO- WAY- S| P- PSTN
TWO- WAY- S| P- PSTN
TWO- WAY- S| P- PSTN

TWO- WAY- S| P- GENESYS- RDN

TWO- WAY- S| P- GENESYS- RDN

TWO- WAY- S| P- GENESYS- RDN

TWO- WAY- S| P- GENESYS- RDN

TWO- WAY- S| P- GENESYS- RDN

TWO- WAY- S| P- GENESYS- RDN
TWO- WAY- S| P- GENESYS- RDN

PSTN aut hentication inclnternal Credentials enabl ed

policy call Routing el enentRoutingPriority
policy signaling ipSignalingProfile

medi a medi al pl nterfaceG oupNane UNTRUSTED
ingressl pPrefix 10.35.8.146 32

nmode i nService

state enabl ed

policy callRouting

policy signaling ipSignalingProfile
signaling registration

nedi a nmedi al pl nt erf aceG oupNane
ingresslipPrefix 0.0.0.0 0

node i nService
state enabl ed

#d obal Configuration

#Rout e Label s

set global call Routing routinglLabel TO TWO WAY_GENESYS routi ngLabel Route 0 routeType trunkG oup

set global call Routing routinglLabel TO TWO WAY_GENESYS routingLabel Route 0 trunkG oup TWO WAY- S| P- CENESYS
set global call Routing routinglLabel TO TWO WAY_GENESYS routingLabel Route 0 i pPeer GENESYS

conmi t

set global call Routing routinglLabel TO TWO WAY_PSTN routi ngLabel Route 0 routeType trunkG oup

set global callRouting routinglLabel TO TWO WAY_PSTN routi ngLabel Route 0 trunkG oup TWO WAY- Sl P- PSTN

set global call Routing routinglLabel TO TWO WAY_PSTN routi ngLabel Route 0 i pPeer PSTN

commi t

#Rout es

set global callRouting route trunkG oup TWO WAY- SI P- GENESYS LI TTLE standard Sonus_NULL Sonus_NULL all all ALL none
Sonus_NULL routingLabel TO TWO WAY_PSTN

set global callRouting route trunkG oup TWO WAY- SI P- GENESYS- RDN LI TTLE standard Sonus_NULL Sonus_NULL all all ALL
none Sonus_NULL routinglLabel TO TWO WAY_GENESYS

set global callRouting route trunkG oup TWO WAY- SI P- PSTN LI TTLE st andard Sonus_NULL Sonus_NULL all all ALL none
Sonus_NULL routingLabel TO TWO WAY_GENESYS

commi t

exit
Test Results
Table 2: Test Results

S.No Procedure Observation Result Comment
Inbound calls

1 Inbound Call to Agent released by caller Pass

2 Inbound Call to Agent released by agent Pass

3 Inbound Calls rejected Pass

4 Inbound Call abandoned Pass

5 Inbound Call to Route Point with Treatment Pass

6 Interruptible Treatment Pass

7 IVR (Collect Digit) Treatment Pass

8 Inbound Call routed by using 302 out of SIP Server signaling path Pass
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Outbound Calls

9 1PCC Outbound Call from SIP Endpoint to external destination Pass
10 3PCC Outbound Call to external destination Pass
11 1PCC Outbound Call Abandoned Pass

Music on hold
12 Caller is put on hold and retrieved by using RFC 2543 method Pass
13 T-Lib-Initiated Hold/Retrieve Call with MOH using RFC 3264 method Pass

Call Transfers

14 3PCC 2 Step Transfer to internal destination by using re-INVITE method Pass
15 3PCC Alternate from consult call to main call Pass
16 1PCC Unattended (Blind) transfer using REFER Pass
17 1PCC Attended Transfer to external destination Pass
18 3PCC Two Step Conference to external party Pass
19 3PCC (same as 1PCC) Single-Step Transfer to another agent Pass
20 3PCC Single Step Transfer to external destination using REFER Pass
21 3PCC Single Step Transfer to internal busy destination using REFER Pass

Other scenarios

22 Early Media for Inbound Call to Route Point with Treatment Pass
23 Early Media for Inbound Call with Early Media for Routed to Agent Pass
24 Inbound call routed outbound (Remote Agent) using INVITE without SDP Pass
25 Call Progress Detection Pass
26 Out of Service detection. Checking MGW live status Pass
27 SIP Authentication for outbound calls Not
Supported

28 SIP Authentication for incoming calls Pass

Remote Agent behind
SBC scenarios

29 T-Lib-Initiated Answer/Hold/Retrieve Call for Remote SIP endpoint which Pass
supports the BroadSoft SIP Extension Event Package

30 3PCC Outbound Call from Remote SIP endpoint to external destination Pass

31 3PCC 2 Step Transfer from Remote SIP endpoint to internal destination Pass

32 1PCC Attended Transfer from Remote SIP endpoint to external destination Pass
Conclusion

These Application Notes describe the configuration steps required for Sonus SBC 5XX0 to successfully interoperate with Genesys Voice Platform. All
feature and serviceability test cases were completed and passed with the exceptions/observations noted in Test Results.

Appendix A

The following new configurations are included in this section:

1. SIP Server standard configuration

2. DN Configuration
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3. EpiPhone configuration

1. SIP Server standard configuration

Information below displays how objects are configured by default.

Table 3: SIP Server standard configuration

SIP Server Application CME Options TServer section

SIP-hold-rfc3264=true
router-timeout=30

default-dn=
blind-transfer-enabled=true
resource-management-by-rm=true
msml-support=true

sip-enable-moh=true

2. DN Configuration

Table 4: DN Configuration

Name Number Name in
CME

MGW- MGW- MGW-
TRUNK TRUNK TRUNK
Ext-DN1 21001 N/A
Ext-DN2 21002
SIP-DN1 7101 7101
SIP-DN2 7102 7102
SIP-RDN 7200 7200
SIP-UNKN 7777 N/A
RP 5000 5000
RP1 5001 5001
RP2 5002 5002

SVC_MSML | SVC_MSML @ SVC_MSML

CME Options TServer
section

refer-enabled=true
contact=<TSE_CONTACT>
oos-check=10

oos-force=5
oosp-transfer-enabled=true
sip-replaces-mode=2

N/A

refer-enabled=false
ring-tone-on-make-call=false
make-call-rfc3725-flow=1
contact=*

refer-enabled=true
ring-tone-on-make-call=false
make-call-rfc3725-flow=1
contact=*
sip-cti-control=talk,hold

N/A

prefix=msml=

Comment

TSE

SIP endpoint which supports the BroadSoft SIP Extension Event
Package.

MS
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contact=<MS_CONTACT>
service-type=msml

subscription-id= Environment

3. EpiPhone configuration

Content of configuration file esttt.conf:
Table 5: EpiPhone configuration
[TcCM]

sitel = UTE_HOME
connect-on-startup = true
open-log-on-startup = false

log-to-file = epi-phone.log

#
#

[UTE_HOME]

server = (host=<SIP_SERVER_HOST_IP> port=<SIP_SERVR_TLIB_PORT>)
sip-register = false

dnl = 7101,name="Alice",mkcall="7102"

dn2 = 7102,name="Bob"

dn3 = 7200,name="John"

dn4 = 5000,pool="shared"
dn5=5001,pool="shared",script="annc=(PROMPT=(\"1\"=(INTERRUPTABLE=1,ID=1)))"

dn6=5002,pool="shared",script="collect=(MAX_DIGITS=4,RESET_DIGITS=11,BACKSPACE_DIGITS=22, TOTAL_TIMEOUT=100)"
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